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Chapter 1

Fritzing Parts SVG Editor

This program is meant to fill a missing feature of the Fritzing program, an editor for creating the part graphics. Inkscape
or Illustrator are really poor choices for creating these sorts of graphics or at least I found Inkscape frustrating to use to
create breadboard or PCB layouts, esp. when compared to KiCAD’s footprint editor. Placing accurately sized graphics
in accurate locations is not really what Inkscape is specifically designed to do. It is meant for creating artwork. For my
initial parts, I ended up hand editing the SVG files with a text editor, with a little scripting help. Then I wrote this program.
Unlike "typical" graphics editing program, this program does not allow for placing or moving graphical elements with the
pointer (mouse, etc.). Instead, to place or edit a graphical element, a dialog box is displayed and one enters the exact
numerical location, size, etc. This might seem clunky to some people, but it is designed to allow direct transfer from
a datasheet drawing, which after all is loaded down with actual measurements (numbers!). For people who have an
aversion to their keyboards, there is always Inkscape or Illustrator.

Fritzing should eventually have its own built-in graphical part editor (much like KiCAD (and I guess EagleCAD) does. I
have no problem with the Fritzing developers using this program as a basis or inspiration.
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Chapter 2

Main GUI

The main gui, shown below, has standard menu bar and three tabs, one for each of the three images used in Fritzing:
Breadboard view, Schematic, and PCB view.

Figure 2.1: The main GUI of the Fritzing Parts SVG Editor program

There are four menus on the top menu bar, a file menu, an edit menu, an options (preferences) menu, and a help menu.



4 Main GUI

2.1 File menu

Figure 2.2: The File menu

The File menu has the has the standard items: New, which clears the current part, Open, which loads a part from disk,
Save and Save As..., which saves the current part to disk, and Edit, which exits the program.

The Open and Save options don’t take a final filename, instead they take a "prefix", to which is appended "_Breadboard.-
svg", "_Schematic.svg", and "_PCB.svg" for each of the three views. In other words, opening and saving involves three
files (although one or two can be ommited on input, in which case the missing files yield a blank image for those view(s)).

2.2 Edit menu

Figure 2.3: The Edit menu

The Edit menu has the standard editing related items.
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2.3 Options menu 5

2.3 Options menu

Figure 2.4: The Options menu

The Options menu has three items: Edit Configuration, Load Configuration, and Save Configuration. These items
allow for editing, loading, and saving the configuration (preferences). See Preferences.

2.4 Help menu

Figure 2.5: The Help menu

The Help menu contains a top-level index into the included help pages.

2.5 Editing tabs

The main area of the main GUI contains three tabbed panes, one for each of the three images used in Fritzing: Bread-
board view, Schematic, and PCB view. All three have the same layout with the same GUI elements, but are actually
independent. Each tabbed pane contains an image view area, a set of tool buttons to the right and coordinate informa-
tion along the bottom. The tool buttons and the coordinate information are the same for all three views, anthough the
details of how the some of the tool buttons work are tab specific and the actually coordinate information is itself specific
to each tab. See Common GUI elements for details about the common features and Breadboard Editor, Schematic
Editor, and PCB Editor for the tab specific features and functions.
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Chapter 3

Preferences

The preferences are stored in a text file in the user’s home directory (folder). The file is named .fritzingpartssvgeditor
under Linux and MacOSX and fritzingpartssvgeditor.rc under MS-Windows. There are five preferences:

Units The units to use for the width and height. Can me either mm (milimeters) or inch (inches)

Width The real world width (in Units above) of the viewport.

Height The real world height (in Units above) of the viewport.

Viewport Width The numerical width of the viewport

Viewport Height The numerical height of the viewport

These are the default initial values to use. When loading a file, the values stored in the file are used. The aspect ratio of
the Width to Height should be the same as the aspect ratio of the Viewport Width to Viewport Height to insure square
pixels. Typically the Viewport Width and Viewport Height will be a constant multiple of the Width and Height respectively.
The Viewport determines the coordinate system used to place and size graphical elements. The Viewport origin (upper
left corner) is always 0,0.
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Chapter 4

Common GUI elements

4.1 Coordinate Information

Along the bottom of each tab pane is information about the coordinate system in use for the current pane. First (going
from left to right) is the physical size, in either milimeters or inches, then the current viewport, and then finally the current
pointer position in the viewport coordinate system. Additionally, a dashed box is shown on the drawing area showing
the bounds of the viewport coordinate system.

4.2 Tool Buttons

To the right of the drawing display area are a collection of tool buttons. There six buttons for inserting graphical elements.
These buttons are tab specific and their functionallity is described in the tab-specific sections of this manual. The bottom
three buttons are the same for all three tabs. The bottom threse buttons are:

Size The Side tool button changes the coordinate system. It displays a dialog box asking for new values for the width,
height, units, and viewport.

ShrinkWrap The ShrinkWrap tool button "shrink wraps" a (presumably) finished part. It recomputes a viewport that
just encloses the part. This includes computing the exact size of the part.

Zoom The Zoom tool button lets you zoom in or out. See Keyboard and mouse bindings.

4.3 Keyboard and mouse bindings

There are some common keyboard and pointer bindings. There is a context menu bound to the right pointer button.
Right-clicking on a graphical element brings up a menu of things you can do to that element: delete or edit, with keyboard
accelerators Delete and E, respectively.

Additionally, the F1 key is bound to zoom in, the F2 key is bound to zoom out, and the F3 is bound to zoom 1:1.
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Chapter 5

Breadboard Editor

The breadboard editor implements six graphical elements: pins, rectangles, lines, circles, arcs, and text, using six tool
buttons. Each of the tool buttons opens a dialog box where the user can enter the information about the graphical
element.

5.1 Pins

Breadboard pins are always drawn as filled circles. The breadboard pin dialog box, shown below, asks for the position
(center), the diameter, the color, and the pin number. Pins are automatically auto-incremented starting at the last pin
entered. The position is in viewport coordinates, as is the diameter. The default color is black.

Figure 5.1: Breadboard Pin Dialog

5.2 Rectangles

Rectangles can be filled with a solid color or just be an outline. The breadboard rectangle dialog box, shown below,
asks for the position (upper left corner), size (width and height), the line thickness (for outline rectangles), color, and if
you want the rectangle filled or not. The position and size are in viewport coordinates. The default color is black.



12 Breadboard Editor

Figure 5.2: Breadboard Rectangle Dialog

5.3 Lines

The breadboard line dialog box, shown below, asks for the endpoints of the line (X1, Y1, X2, Y2), the line thickness and
the color. The endpoints are in viewport coordinates. The default color is black.

Figure 5.3: Breadboard Line Dialog

5.4 Circles

Breadboard circles can be filled or hollow. The breadboard circle dialog box, shown below, asks for the position (center),
the diameter, the center size (hole diameter), and the color. The position and the diameters are in viewport coordinates.
The default color is black.
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5.5 Arcs 13

Figure 5.4: Breadboard Circle Dialog

5.5 Arcs

Breadboard arcs can be either pie slices or bare arcs. If the center diameter, the arc will be a pie slice (filled), otherwise,
the arc will be a bare arc. The breadboard arc dialog box, shown below, asks for the position (center), the diameter, the
center size (hole diameter), and the color. The position and the diameters are in viewport coordinates. The default color
is black.

Figure 5.5: Breadboard Arc Dialog

5.6 Text

The breadboard text dialog box, shown below, asks for the position (lower left), the size in points, the font, the text, and
the color. The position is in viewport coordinates. The default color is black.
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Figure 5.6: Breadboard Text Dialog
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Chapter 6

Schematic Editor

The schematic editor implements six graphical elements: pins, rectangles, lines, circles, arcs, and text, using six tool
buttons. Each of the tool buttons opens a dialog box where the user can enter the information about the graphical
element.

6.1 Pins

The Schematic implements "pins" as short lines with a small filled circle at the end, meant to be used as a connection
point. The line can have an optional larger outline circle (at the opposite end from the connection) to indicate an inverted
input or output. Also pins on a schematic are labeled with at least a pin number and optionally a pin name. The
schematic pin dialog, shown below, asks for the position (this is the center of the small filled circle at the end of the line),
the orientation of the pin (this corresponds to the side of the part’s (rectangular) body: left, right, top, bottom), whether
the pin is inverted, the pin number, the (optional) pin name, the color, the line thickness, the size of the textual elements,
and the font to use for the textual elements.

Figure 6.1: Schematic Pin Dialog

The length would always be the distance from the part’s (rectangular) body to the center of the connection point, as
shown here (both pins have the same length):



16 Schematic Editor

Figure 6.2: Example pins: both oriented left, both the same length.

6.2 Rectangles

Rectangles can only be an outline. The schematic rectangle dialog box, shown below, asks for the position (upper left
corner), size (width and height), the line thickness, and color. The position and size are in viewport coordinates. The
default color is black.

Figure 6.3: Schematic Rectangle Dialog

6.3 Lines

The schematic line dialog box, shown below, asks for the endpoints of the line (X1, Y1, X2, Y2), the line thickness and
the color. The endpoints are in viewport coordinates. The default color is black.

Figure 6.4: Schematic Line Dialog
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6.4 Circles 17

6.4 Circles

Schematic circles can be filled or hollow. The schematic circle dialog box, shown below, asks for the position (center),
the diameter, the center size (hole diameter), and the color. The position and the diameters are in viewport coordinates.
The default color is black.

Figure 6.5: Schematic Circle Dialog

6.5 Arcs

Schematic arcs can be either pie slices or bare arcs. If the center diameter, the arc will be a pie slice (filled), otherwise,
the arc will be a bare arc. The schematic arc dialog box, shown below, asks for the position (center), the diameter, the
center size (hole diameter), and the color. The position and the diameters are in viewport coordinates. The default color
is black.

Figure 6.6: Schematic Arc Dialog

6.6 Text

The schematic text dialog box, shown below, asks for the position (lower left), the size in points, the font, the text, and
the color. The position is in viewport coordinates. The default color is black.
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Figure 6.7: Schematic Text Dialog
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Chapter 7

PCB Editor

The PCB editor implements six graphical elements: pins, rectangles, lines, circles, arcs, and text, using six tool buttons.
Each of the tool buttons opens a dialog box where the user can enter the information about the graphical element.

7.1 Pins

PCB pins are always drawn as circles, with a possible hole drilled in the center. The PCB pin dialog box, shown below,
asks for the position (center), the diameter, the drill size, and the pin number. Pins are automatically auto-incremented
starting at the last pin entered. The position is in viewport coordinates, as are the diameters. The default color is copper
and pins are always on the copper layers.

Figure 7.1: PCB Pin Dialog

7.2 Rectangles

Rectangles can only be an outline. The PCB rectangle dialog box, shown below, asks for the position (upper left corner),
size (width and height), and the line thickness. The position and size are in viewport coordinates. The color is white and
rectangles are always on the silkscreen.
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Figure 7.2: PCB Rectangle Dialog

7.3 Lines

The PCB line dialog box, shown below, asks for the endpoints of the line (X1, Y1, X2, Y2), and the line thickness. The
endpoints are in viewport coordinates. The color is white and lines are always on the silkscreen.

Figure 7.3: PCB Line Dialog

7.4 Circles

PCB circles can be filled or hollow. The PCB circle dialog box, shown below, asks for the position (center), the diameter,
and the center size (hole diameter). The position and the diameters are in viewport coordinates. The color is white and
circles are always on the silkscreen.

Figure 7.4: PCB Circle Dialog
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7.5 Arcs 21

7.5 Arcs

PCB arcs can be either pie slices or bare arcs. If the center diameter, the arc will be a pie slice (filled), otherwise, the
arc will be a bare arc. The PCB arc dialog box, shown below, asks for the position (center), the diameter, and the center
size (hole diameter). The position and the diameters are in viewport coordinates. The color is white and arcs are always
on the silkscreen.

Figure 7.5: PCB Arc Dialog

7.6 Text

The PCB text dialog box, shown below, asks for the position (lower left), the size in points, the font, and the text. The
position is in viewport coordinates. The color is black and text is always on the silkscreen.

Figure 7.6: PCB Text Dialog
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Chapter 8

GNU GENERAL PUBLIC LICENSE

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software–to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation’s software
and to any other program whose authors commit to using it. (Some other Free Software Foundation software is covered
by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to
make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that
you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free
programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender
the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you
modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no warranty
for this free software. If the software is modified by someone else and passed on, we want its recipients to know that
what they have is not the original, so that any problems introduced by others will not reflect on the original authors’
reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE
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TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it
may be distributed under the terms of this General Public License. The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that
is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into
another language. (Hereinafter, translation is included without limitation in the term "modification".) Each licensee is
addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute
a work based on the Program (independent of having been made by running the Program). Whether that is true depends
on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in
exchange for a fee.

1. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program,
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also
meet all of these conditions:

a) You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in
whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.

c) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide
a warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this
License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on
the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the
Program, and can be reasonably considered independent and separate works in themselves, then this License, and its
terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

1. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:
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a) Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections
1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three
years, to give any third party, for a charge no more than your
cost of physically performing source distribution, a complete
machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer
to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you
received the program in object code or executable form with such
an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work,
complete source code means all the source code for all modules it contains, plus any associated interface definition
files, plus the scripts used to control compilation and installation of the executable. However, as a special exception,
the source code distributed need not include anything that is normally distributed (in either source or binary form) with
the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that
component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

1. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically termi-
nate your rights under this License. However, parties who have received copies, or rights, from you under this
License will not have their licenses terminated so long as such parties remain in full compliance.

You are not required to accept this License, since you have not signed it. However, nothing else grants you permission
to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this
License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your
acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program
or works based on it.

1. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives
a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients’ exercise of the rights granted herein. You are not
responsible for enforcing compliance by third parties to this License.

(a) If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section
is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
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system, which is implemented by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

1. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit geograph-
ical distribution limitation excluding those countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

1. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which
applies to it and "any later version", you have the option of following the terms and conditions either of that version or of
any later version published by the Free Software Foundation. If the Program does not specify a version number of this
License, you may choose any version ever published by the Free Software Foundation.

1. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different,
write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write
to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two
goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse
of software generally.

NO WARRANTY

1. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PR-
OGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WIT-
HOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQ-
UENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR
THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where
the full notice is found.
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\<one line to give the program’s name and a brief idea of what it does.\>
Copyright (C) \<year\> \<name of author\>

This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type ‘show w’.
This is free software, and you are welcome to redistribute it
under certain conditions; type ‘show c’ for details.

The hypothetical commands ‘show w’ and ‘show c’ should show the appropriate parts of the General Public License.
Of course, the commands you use may be called something other than ‘show w’ and ‘show c’; they could even be
mouse-clicks or menu items–whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright disclaimer"
for the program, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program ‘Gnomovision’ (which makes passes at compilers)
written by James Hacker.

<signature of Ty Coon>, 1 April 1989 Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is
what you want to do, use the GNU Library General Public License instead of this License.
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Chapter 9

Help

This help window contains some basic navigation features. There are buttons for traversing the history stack. There are
also key bindings within the help window itself:

• s Search forward. Searches forward in the text for the next occurrence of the specified text.

• r Search backward. Searches backward in the text for the next occurrence of the specified text.

• f History forward. Goes to the next page in the history stack.

• b History backward. Goes to the previous page in the history stack.

• Tab Next link. Goes to the next hyperlink.

• Control-Tab Previous link. Goes to the previous hyperlink.
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Chapter 10

Module Documentation

10.1 Fritzing Parts SVG Editor

Create and edit SVG SVG files used as the images for the Fritzing Parts editor.

10.1.1 SYNOPSIS

FritzingPartsSVGEditor [X11 Resource Options] [options] [fileprefix]

10.1.2 DESCRIPTION

The Fritzing Parts SVG Editor creates and edits the SVG files used as the images for the Fritzing Parts editor. It is NOT
drawing program (like inkscape or Adobe Illustrator). It is oriented towards placing graphical elements precisely, using
exact numberical placement values. Be prepared to make extensive use of the oblong thing with the 100 or so buttons
on it and expect to make little use of the other thing you move around! There is no dragging or dropping or click to place
elements. The lack of such features is deliberate. Please read the whole manual for complete documentation on the
use of this program.

10.1.3 OPTIONS

None at present.

10.1.4 PARAMETERS

An option filename prefix. The files the program uses are named using this prefix, with "_Breadboard.svg", "_Schematic.-
svg", and "_PCB.svg" appended.

10.1.5 FILES

Preferences file (Tcl/Tk otions format):

$(HOME)/.fritzingpartssvgeditor or $(HOME)/fritzingpartssvgeditor.rc
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10.1.6 AUTHOR

Robert Heller <heller@deepsoft.com>
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